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1 Introduction 

L’Aperio LV1 IVD est destiné à être utilisé pour visualiser les lames en verre à distance et contrôler 
de manière robotique le LV1 tout en visualisant les lames en verre. L’Aperio LV1 IVD peut 
également être utilisé pour numériser les lames de microscopes en verre traditionnelles par un 
processus de numérisation et pour compresser et visualiser les images complètes des lames 
virtuelles. Cet appareil ne doit être manipulé que par des utilisateurs/techniciens dûment formés 
possédant une excellente connaissance de l’équipement et autorisés à le manipuler. Les bonnes 
pratiques laboratoires et autres politiques et procédures requises par votre établissement doivent 
être suivies lors de la préparation, le traitement, le stockage et la mise au rebut des lames. 

Restreignez toute utilisation de cet équipement à ces fins et conformez-vous aux instructions 
données dans ce guide. Toute utilisation de cet appareil ne respectant pas les instructions 
contenues dans ce guide peut annuler votre contrat d’entretien de l’équipement. 

L’Aperio LV1 IVD Visualisation live et scanner de paillasse a été fabriqué conformément aux normes 
les plus strictes en matière de qualité.  

Veuillez noter qu’un entretien annuel est nécessaire pour maintenir le niveau de performance 
du scanner.  

Pour obtenir de l’aide concernant ce produit, contactez les services techniques de Leica Biosystems 
(voir Support client). Veuillez également noter que Leica Biosystems propose une formation. 

Mesures de sécurité 

Manipulation et levage de l’instrument 
 Cet instrument est lourd. Ne manipulez pas et ne soulevez pas l’instrument seul. Au moins 

deux personnes sont nécessaires pour soulever l’instrument en toute sécurité. 

 Soulevez l’instrument uniquement par sa base et n’appliquez pas une trop forte pression 
sur le boîtier. 

 N’utilisez l’instrument lorsque la porte latérale est ouverte. 

 L’instrument doit être éteint et le cordon d’alimentation débranché avant l’ouverture de la 
porte latérale. 

 Même si l’instrument est testé pour garantir une bonne calibration après le transport, il est 
conseillé d’éviter tout choc inutile, par exemple en laissant tomber l’instrument. 
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Sécurité biologique 
 Consultez la fiche signalétique des colorants et des réactifs que vous utilisez, et suivez les 

politiques et les procédures en matière de biosécurité de votre établissement pour la 
manipulation sécuritaire du matériel biologique. Il peut s’avérer nécessaire de porter les 
gants ou une blouse appropriée. 

 

Si des échantillons infectieux sont amenés dans ou entrent en contact avec 
l’instrument, il est conseillé de désinfecter le plateau d’échantillons et le boîtier 
de l’instrument, même s’il est très peu probable que les pièces internes de 
l’instrument soient contaminées. Veuillez noter que les composants internes de 
l’instrument peuvent être décontaminés uniquement par du personnel autorisé 
et qualifié. Contactez les services techniques Leica pour obtenir de l’aide. 

 

Maintenance de l’instrument 
Pour une performance optimale, une routine de maintenance effectuée par un membre du 
personnel d’entretien qualifié est recommandée une fois par an après l’expiration de la période 
de garantie. 

Sécurité et sauvegarde informatique 
 L’Aperio LV1 Visualisation live et scanner de paillasse est livré avec un ordinateur de 

haute qualité, mais aucun mécanisme de sauvegarde ou autre redondance des données 
n’est installé. 

 Aucun logiciel de protection de l’ordinateur ou des données contre les programmes 
malveillants n’est installé. 

Lorsque vous utilisez l’Aperio LV1 Visualisation live et scanner de paillasse, vous êtes responsable 
de la sauvegarde et de la sécurité des données. 

Recommandations en matière de cybersécurité 

 

AVERTISSEMENT : Le poste de travail utilisé avec ce produit est vulnérable aux 
programmes malveillants, aux virus, à la corruption des données et aux 
infractions à la confidentialité. Référez-vous aux recommandations ci-dessous 
pour protéger le poste de travail de tels problèmes. 

 

 Seul un personnel autorisé peut accéder physiquement au poste de travail.  

 Utilisez des mots de passe forts et changez votre mot de passe périodiquement.  

 Vérifiez que le pare-feu Windows est activé sur votre poste de travail. 
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 Si votre produit est livré avec un mot de passe par défaut déjà défini, veuillez changer le 
mot de passe. 

 Réglez l’écran de veille Windows pour désactiver le poste en cas d’inactivité et demander 
la connexion pour le réactiver. Contactez votre service informatique si vous avez besoin 
d’aide à cet égard. 

 Il est recommandé de crypter le disque dur du poste de travail pour prévenir l’exposition 
ou le vol de données sensibles. BitLocker Drive Encryption est installé sur votre poste de 
travail et peut être activé. Contactez votre service informatique si vous avez besoin 
d’aide à cet égard. 

 Le logiciel antivirus Windows Defender est installé sur le poste de travail. Nous vous 
recommandons d’exécuter des analyses périodiques sur l’antivirus. Les analyses 
antivirus doivent être configurées pour s’exécuter en dehors des heures de pointe car 
elles consomment beaucoup de temps processeur et peuvent interférer avec l’utilisation 
du produit. Mettez à jour le logiciel antivirus lorsque des mises à jour sont disponibles. 

 Le poste de travail est vulnérable aux programmes malveillants et virus provenant de 
supports physiques tels que des CD, DVD ou lecteurs USB. Pour réduire le risque de 
corruption des données ou de changements non autorisés des paramètres, utilisez 
uniquement des supports physiques tels que des CD, DVD ou lecteurs USB qui sont 
connus pour être exempts de virus et de programmes malveillants. Contactez votre 
professionnel informatique pour obtenir une assistance. 

 Sauvegardez périodiquement le contenu du disque dur du poste de travail. 

 Lorsque vous vous connectez à l’Aperio eSlide Manager, assurez-vous que le cryptage 
SSL est activé pour protéger la confidentialité de vos données. Contactez votre service 
informatique si vous avez besoin d’aide à cet égard. 

 Pour prévenir l’accès non autorisé aux ports du poste de travail LV1 IVD (y compris les 
ports USB), nous vous recommandons de placer le poste de travail LV1 IVD installé et 
configuré dans une armoire informatique verrouillée munie d’un ventilateur. 

 Si vous utilisez Team Viewer pour visualiser à distance les images sur le LV1 IVD : 

 Protégez le mot de passe Team Viewer de l’utilisation par les autres 

 Changez le mot de passe par défaut de Team Viewer. 

 Fermez Team Viewer lorsque votre session est terminée. 

 Changez périodiquement votre mot de passe et utilisez des mots de passe forts. 

Lecture de codes-barres 
Les codes-barres de mauvaise qualité peuvent entraîner des erreurs de décodage du code-barres. 

Utilisez des types de code comportant une vérification ou une correction des erreurs, ainsi que des 
étiquettes dotées d’un bon contraste et de grands caractères bien définis. 
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Mesure en cas de dysfonctionnement 

 

MISE EN GARDE : en cas de dysfonctionnement, vous devrez peut-être ouvrir la 
porte d’accès à l’instrument. Appelez d’abord les services techniques Leica pour 
obtenir de l’aide. Consultez la section Ouverture de la porte d’accès pour 
obtenir des instructions. 

 Si un message d’erreur s’affiche, lisez et copiez/enregistrez-le en vue d’une utilisation 
ultérieure. 

 Lisez le manuel pour savoir si ce type de dysfonctionnement est connu, décrit et peut 
être résolu par l’utilisateur. Consultez la section Étapes de dépannage pour obtenir des 
informations. 

 Contactez les services techniques Leica (consultez Support client qui se trouve au début 
de ce guide). 

Description générale 

Contenu livré 
 Aperio LV1IVD Visualisation live et scanner de paillasse 

 Plateau de lames, x1 

 Câble USB AB, x2 

 Câble de liaison de la caméra, x1 

 Plusieurs cordons d’alimentation spécifiques au pays (veuillez utiliser le cordon 
d’alimentation adapté à votre situation géographique) 

 Guide d’utilisation de l’Aperio LV1 IVD Visualisation live et scanner de paillasse 
 Guide d’installation rapide de l’Aperio LV1 IVD Visualisation live et scanner de paillasse 
 Ordinateur, y compris le clavier et la souris 
 Moniteur, y compris les câbles 

Caractéristiques techniques 

Caractéristique Détails 

Description Visualisation live et scanner de paillasse droit  
Instrument de paillasse fermé destiné à une utilisation dans un 
environnement éclairé 

Interrupteur 
de secteur 

Situé à l’arrière de l’instrument. 
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Caractéristique Détails 

Portoir 
d’échantillons 

Quatre lames de microscope 

Lames acceptées Le tissu étalé est incorporé entre une lame et une lamelle couvre-objet 
prises en charge. 

 Taille minimale de la lame : 24,7 mm (largeur) x 74,7 mm 
(longueur) x 1 mm (épaisseur) 

 Taille maximale de la lame : 26,3 mm (largeur) x 76,5 mm 
(longueur) x 1,5 mm (épaisseur) 

La lamelle couvre-objet/l’étiquette ne doit pas dépasser du bout de la 
lame de microscope en verre. La lamelle couvre-objet entière et 
l’étiquette doivent être collées à la lame de microscope en verre. Aucune 
partie et aucun bord de l’étiquette ou de la lamelle couvre-objet ne doit 
dépasser. La surface externe de la lame doit être sèche. Aucun liquide ne 
doit s’écouler de la zone de l’échantillon. 

Les lames sont généralement préparées en utilisant : 

 une lamelle couvre-objet de verre avec un milieu de montage, un 
baume d’inclusion Eukitt ou de l’eau 

 Une lamelle couvre-objet en film avec colle intégrée 

L’épaisseur maximale du tissu/frottis (y compris le milieu de montage) est 
de 130 µm. 

Lamelles 
couvre-objet 
acceptées 

Prend en charge des lamelles couvre-objet d’une épaisseur de 100 à 
170 µm, fabriquées dans un matériau typique de lamelle couvre-objet : 
lamelle couvre-objet de microscope standard en verre ou film de 
triacétate de cellulose (film couvre-objet de microscope). 

Surface de 
spécimen 

≤ 50 mm x 22 mm 

Zone d’étiquetage 20 mm x 22 mm Étiquette manuscrite/imprimée matte non transparente 
(à réflexion similaire à celle du papier). 

Épaisseur maximale de l’étiquette : 200 µm 

La taille minimale de l’étiquette doit être de 12 mm x 25 mm (pour 
détecter la présence de la lame). Les étiquettes ne doivent pas dépasser 
du bout des lames ou être décollées. 
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Caractéristique Détails 

Système optique 
du microscope 

Objectif EC Plan Neofluar 1,25x 

Objectif EC Plan Neofluar 5x 

Objectif EC Plan Neofluar 20x 

Objectif EC Plan Neofluar 40x 

Grossissements proposés à l’utilisateur dans le logiciel : 

Résumé : ≈ 10 µm/pixel 

2,5x : 2,16 µm/pixel 

5x 1,08 µm/pixel 

10x : 0,54 µm/pixel 

20x : 0,27 µm/pixel 

40x : 0,138 µm/pixel  

63x : 0,086 µm/pixel (zoom numérique) 

Imagerie en 
champ clair 

Caméra numérique couleur à 12 Mégapixels 

Fréquence de mise à jour de l’affichage : 15 ips 

Éclairage DEL haute puissance 

Imagerie de 
l’étiquette/du 
code-barres 

Imagerie par épi-illumination de toutes les régions étiquetées de toutes 
les lames insérées à l’aide d’une caméra numérique 

Composants 
motorisés 

Platine X-Y pour le déplacement des échantillons en mode manuel et en 
mode Numérisation 

Commande de mise au point rapide 

Changeur d’objectif motorisé, 3 positions minimum 

Système de 
mise au point 

Mise au point automatique par infrarouge brevetée, effectue 
automatiquement la mise au point sur l’interface verre-échantillon 

Mise au point automatique basée sur l’image 

Mise au point manuelle en mode de microscopie live 

Vitesse de 
numérisation 

90 s/lame, 15 x 15 mm, à 0,27 µm/pixel (20x) et 180 s/lame, 
15 x 15 mm, à 0,138 µm/pixel (40x) 
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Caractéristique Détails 

Logiciel 
d’application 

Logiciel : 

 Visualisation en temps réel et à distance des lames de microscope  
 Partage des cas, comparaisons en côte à côte des échantillons 
 Mode Scanner (imagerie automatisée de la lame entière) 
 Visionneuse 
 Lecture de l’étiquette/du code-barres 
 Base de données SQL centralisée 
 Annotations, mesures  
 Exportation des images vers un logiciel tiers  
 Connectivité SGH/SGL par protocole HL7 préparé 

Dimensions l x L x H = 425 mm x 540 mm x 440 mm 

Poids 28 kg 

Alimentation Universelle 100 à 240 V CA +- 10 %, 50/60 Hz, 4 à 2 A 

Surtension transitoire jusqu’à catégorie II 

Surtension temporaire au niveau de l’alimentation secteur 

Cordon d’alimentation pour 300 V minimum et de 3 x 18 AWG de diamètre 

Conditions 
d’utilisation 

L’instrument peut être utilisé en toute sécurité entre 5 et 40 °C. L’appareil 
remplit ses caractéristiques de performance entre 15 et 25 °C, humidité 
relative (HR) de 80 % maximum à 31 °C, se réduit de façon linéaire à 
50 % HR maximum à >= 40 °C. 

Conditions 
de stockage 

+5 à 40 °C, 5 à 85 % HR 

Conditions 
de transport 

-25 à +50 °C, 85 % HR maximum 

Expédition sur palette, testée selon la norme ISTA 2B 

Degré de pollution II 
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Caractéristique Détails 

Poste de travail LV1 Ordinateur de bureau de dimension réduite, comme un Dell Optiplex 
ou équivalent. 

 Unité centrale cœur i5-12600 ou équivalent 
 16 Go RAM 
 Combinaison SSD/HDD minimum 2 TB 
 USB2, x4 minimum 
 Double sortie moniteur, port d’affichage (DP) 
 Norme Ethernet 1000 Base-T 
 Préparé pour le transfert d’images via la carte d’acquisition 

Camera Link 
 Clavier (anglais américain) et souris 
 Windows 10 Enterprise, 64 bits préinstallé, anglais 
 Câble d’alimentation 

Écran Type d’écran : LCD (écran plat) recommandé 

Résolution : 1920 x 1080 ou plus 

Taille de l’écran : 24 po ou plus 

Profondeur de couleurs : 16,7 millions de couleurs ou plus 

Luminosité : 250 cd/m2 à 300 cd/m2 (luminosité typique) 

Rapport de contraste : 1000:1 

Exigences 
de qualité 

Le produit est conçu et produit dans le cadre d’un système de gestion de 
la qualité conforme aux normes ISO 9001 et ISO 13485. 

Le produit est conforme aux normes suivantes : 

 Directive européenne relative à la basse tension 2006/95/CE et à 
la directive EMI/RFI 2004/108/CE. 

 Exigences de sécurité pour les équipements électriques de 
laboratoire IL CAN/CSA-C22.2 No. 61010.1-04/CEI 61010-1:2010 
(Troisième édition) 

 Exigences relatives à la CEM de la FCC (47CFR Part 15) et 
CEI 61326-2-6:2013 

Environnement Conforme à la norme RoHS (Restriction des substances dangereuses) 
selon la directive européenne 2011/65/CE 
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Caractéristique Détails 

Exigences de 
bande passante 

La bande passante minimale recommandée pour utiliser l’Aperio LV1 IVD 
est une connexion à Internet de 50 mégabits par seconde (Mbps) ou plus, 
car c’est la valeur pour laquelle le système a été validé. La bande passante 
minimale comprend une vitesse de chargement d’au moins 50 Mbps et 
une vitesse de téléchargement d’au moins 50 Mbps, à la fois pour la 
connexion physique de l’Aperio LV1 IVD et pour la connexion de 
l’utilisateur distant pour contrôler l’Aperio LV1 IVD. 

Si la vitesse de la bande passante est inférieure à 50 Mbps, l’utilisateur 
peut s’attendre à une vitesse d’actualisation inférieure des images 
visualisées à distance. Par conséquent, il est recommandé de confirmer si 
une vitesse de rafraîchissement inférieure à 50 Mbps est acceptable pour 
les utilisateurs potentiels de l’Aperio LV1 IVD en effectuant une 
démonstration en direct dans l’environnement informatique réel 
d’utilisation du LV1 IVD. 

Caractéristiques du produit 
 Microscopie automatisée 

 Imagerie numérique 

 Instrument de paillasse fermé et facile à utiliser 

 Commande directe et pratique sur l’échantillon et le grossissement 

 Outils d’annotation et de mesure 

 Lecture automatique des codes-barres situés sur les lames 

 Numérisation par vignette rapide avec fusion immédiate 

 Différentes options de numérisation interactives et basées sur le profil 

Pertinence de ce manuel 
 Produit : Aperio LV1 IVD, référence n° 23LV100IVD 

 Logiciel : Application Aperio LV1 IVD v5.0.0 et ultérieure 
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Déclaration de destination 
L’Aperio LV1 IVD Visualisation live et scanner de paillasse est un système de capture et de 
visualisation (en local et à distance) des lames de verre examinées par les anatomopathologistes 
pour formuler un avis diagnostique. Il doit être utilisé en tant qu’outil diagnostic in vitro primaire 
par les pathologistes lorsqu’ils formulent une opinion de pathologie sur des échantillons fournis*, 
y compris lors de consultations. 

* Ne pas utiliser si l’examen d’échantillons requiert un objectif à sec dont le grossissement est 
supérieur à 40x. 

Caractéristique de l’échantillon 
Pour réaliser un scan de haute qualité avec simplicité ou une microscopie automatisée, il est 
important de bien préparer sa lame. Les lames doivent être propres et en bon état : aucune bulle 
d’air sous la lamelle couvre-objet, pas de poussière, pas de traces de doigts, pas de marques, pas 
d’écritures, pas d’excès d’adhésif, pas de lames cassées, pas d’ébréchures, pas de rayures, pas de 
lamelles trop grandes, etc. Avant de charger des lames, veillez à ce qu’elles soient toutes 
entièrement séchées (autrement dit, qu’elles ne soient pas humides). Pour obtenir des résultats 
optimaux, les lames scannées doivent toutes être dotées de lamelles couvre-objet.  

Assurez-vous qu’il n’y ait aucune trace de colle sur les bords de la lame qui puisse provoquer le 
collage de la lame dans la platine du scanner ou son blocage. La lamelle couvre-objet/l’étiquette ne 
doit pas dépasser du bout de la lame de microscope en verre. Aucune partie et aucun bord de 
l’étiquette ou de la lamelle couvre-objet ne doit dépasser. La surface externe de la lame doit être 
sèche; aucun liquide ne doit s’écouler de la zone de l’échantillon. 

Le tissu doit être idéalement placé au centre de la lame et éloigné des bords, de l’étiquette et de 
tout autre marquage. Vous trouverez peut être utile de toujours positionner le tissu au même 
emplacement et selon la même orientation sur la lame. Certains problèmes mécaniques rencontrés 
sur la lame peuvent être résolus en nettoyant la lame avec un chiffon en coton ou en aiguisant 
chaque côté avec une lame de rasoir. Des problèmes récurrents sur une même lame peuvent 
nécessiter la préparation d’une nouvelle lame.  

 
 N’utilisez que le strict minimum de colle pour fixer la lamelle couvre-objet. Les excès 

de colle empêchent le localisateur de tissu de faire la différence entre le tissu réel et la 
colle. Si un repère de mise au point se positionne sur de la colle, la lame ne sera pas 
correctement focalisée.  

Ét
iq
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 Veillez à ce que la lame soit totalement propre avant de la scanner. Essuyez-la avec un 
chiffon en coton propre (n’utilisez pas de nettoyant chimique).  

 Les échantillons doivent être incorporés à un milieu de montage, à un baume d’inclusion 
Eukitt ou à de l’eau entre une lame et une lamelle couvre-objet prises en charge.  

 Dimensions maximales des lames prises en charge : (largeur x longueur x épaisseur) : 
26,3 mm x 76,5 mm x 1,5 mm  

 Dimensions minimales des lames prises en charge : (largeur x longueur x épaisseur) : 
24,7 mm x 74,7 mm x 1 mm 

 L’épaisseur des lamelles couvre-objet prises en charge est de 100 à 170 µm (170 µm 
pour des résultats optiques optimaux). Un film de triacétate de cellulose peut être utilisé 
pour remplacer la lamelle couvre-objet.  

La zone d’échantillon de la lame peut être imagée en haute résolution, c’est-à-dire à 50 x 22 mm 
de façon adjacente par rapport à la zone de l’étiquette. 

 

 

Lorsque vous utilisez des lamelles couvre-objet qui ne sont pas fixées à la lame (par 
exemple, des sections congelées récemment préparées), la distance entre la lamelle 
couvre-objet et l’extrémité courte de la lame ne doit pas être inférieure à 4 mm. 
Les lamelles couvre-objet qui se trouvent à moins de 4 mm des bords de la lame 
pourraient être touchées et déplacées par le mécanisme de pince pour lame 
de l’instrument. 

Les coins externes de la zone d’étiquette de la lame sont recouverts par le mécanisme 
de pince pour lame de l’instrument. Les régions recouvertes ne représentent pas plus 
de 4 mm de la zone d’étiquette. Assurez-vous que le texte de l’étiquette, en 
particulier les codes-barres, n’est pas recouvert par le mécanisme de pince pour lame 
de l’instrument. 

 

Pour plus de détails sur les dimensions de l’étiquette, de la lamelle couvre-objet et de la lame, 
consultez la section Caractéristiques techniques. 
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Porte d’accès latérale 
Une porte d’accès latérale a été fournie afin de vous permettre de nettoyer les objectifs de 
l’instrument ou de récupérer les lames si nécessaire. 

 

 

Seul le personnel formé et agréé peut réparer cet instrument. Si vous accédez à 
l’intérieur de l’instrument par la porte latérale, assurez-vous d’abord que 
l’instrument est éteint et débranchez le cordon d’alimentation. Consultez la 
section Ouverture de la porte d’accès pour obtenir des instructions. 

Nettoyage 
Le boîtier de l’instrument peut être nettoyé à l’aide des détergents et des désinfectants de 
laboratoire standard. Évitez de faire entrer des liquides dans l’instrument. L’intérieur de 
l’instrument doit être nettoyé uniquement si cela s’avère nécessaire. Consultez la section 
Nettoyage de l’intérieur du scanner. 
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2 Préparation de 
l’installation 

Ce chapitre aborde l’installation de l’Aperio LV1 IVD Visualisation live et scanner de 
paillasse. Pour obtenir de l’aide, contactez les services techniques Leica (voir 
Support client).  

 

Veuillez consulter le Guide d’installation rapide de l’Aperio LV1 IVD Visualisation live 
et scanner de paillasse pour obtenir des informations sur le déballage et l’installation 
du produit LV1 IVD. Ce chapitre contient des informations importantes que vous 
devez connaître lors de la préparation du site en vue de l’installation, ainsi que les 
mises en garde et les avertissements. 

Déballage 
L’instrument est livré sur palette. Même si l’instrument est testé pour garantir une bonne 
calibration après le transport, évitez tout choc inutile, par exemple en laissant tomber l’instrument. 
Ne manipulez pas et ne soulevez pas l’instrument seul. Au moins deux personnes sont nécessaires 
pour soulever l’instrument en toute sécurité. Manipulez l’instrument par sa base et n’appliquez pas 
une trop forte pression sur le boîtier. 

Numéro de l’instrument et version logicielle 
Le numéro de série et le numéro de l’application logicielle peuvent être consultés en mode 
Visualisation live et dans d’autres modes. Placez votre curseur sur le logo Aperio LV1 IVD pour 
afficher une petite fenêtre qui comporte les informations concernant la version. 

Le numéro de l’instrument est également indiqué sur l’étiquette qui se trouve à l’arrière 
du LV1 IVD.  

Emplacement d’installation 

Position et espacement de l’instrument 
 Cet instrument est uniquement conçu pour une utilisation en intérieur. 
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 N’utilisez pas l’instrument dans des endroits situés à plus de 2 000 mètres au-dessus 
du niveau moyen de la mer. 

 Placez l’instrument sur une surface horizontale dure, dans une pièce propre et sèche 
dotée d’un contrôle de la température. 

 Vérifiez que l’environnement électromagnétique convient à l’utilisation de l’instrument. 
N’utilisez pas cet instrument à proximité de sources de rayonnement électromagnétique 
intense (par exemple, des sources d’ondes radioélectriques intentionnelles non 
blindées), car elles peuvent interférer avec son bon fonctionnement. 

 

 

Assurez-vous que l’arrière de l’instrument est dégagé (au moins 10 cm/4 po) afin 
de garantir un écoulement adéquat de l’air vers et hors des ventilateurs. Les 
câbles doivent être accessibles et ne pas être fortement pliés. Assurez-vous de la 
présence d’un écoulement de l’air vers et hors de l’instrument. Laissez un espace 
suffisant derrière l’instrument pour vous permettre de débrancher facilement le 
cordon d’alimentation si vous devez mettre l’instrument hors tension rapidement. 

Vibration 
Sachez que la vibration peut nuire à la qualité de l’image. Placez l’ordinateur et le moniteur sur une 
table très dure ou sur une table différente, si cela est possible. 

Poussière et pollution 
Évitez d’exposer l’instrument de façon prolongée à la poussière. Celle-ci pénétrera dans 
l’instrument et nuira à la qualité de l’image. Il est conseillé de laisser les rabats de l’instrument 
fermés afin d’empêcher la poussière de pénétrer dans le boîtier. Un filtre est installé sur le 
ventilateur qui se trouve sur l’arrière du boîtier. En particulier dans les environnements 
poussiéreux, vérifiez que le filtre n’est pas bouché et que l’air peut circuler dans le boîtier. 

Température 
Outre les caractéristiques énoncées dans la section Caractéristiques techniques, n’exposez pas 
l’instrument à la lumière directe du soleil. Des changements rapides de température (> 2 °C en 
3 minutes) peuvent nuire à la qualité de l’image lors de l’imagerie automatique.  

Alimentation 
Branchez le cordon d’alimentation à une fiche secteur à 100 à 240 V CA/50 à 60 Hz. L’instrument 
peut être utilisé uniquement sur une fiche d’alimentation mise à la terre. 

 



Chapitre 2 : Préparation de l’installation  

 

Guide d’utilisation de l’Aperio LV1 IVD Visualisation live et scanner de paillasse  
Révision B © Leica Biosystems Imaging, Inc. 2024 | Page 22 

 

Branchez le cordon d’alimentation de l’instrument à un bloc multiprises de 4 à 
6 fiches protégé contre les surtensions, situé à proximité du plan de travail pour 
un accès facile.  

Pour protéger le scanner, Leica Biosystems recommande l’utilisation d’un onduleur 
agréé pour 2 200 VA et doté un régulateur de puissance pour protéger les charges 
connectées contre les surtensions et les pics, la foudre et autres perturbations 
électriques. L’onduleur procure 30 minutes de fonctionnement additionnel au 
scanner, ce qui vous permet de l’éteindre en toute sécurité. 
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3 Prise en main 

Cette section est destinée à vous aider lors de la prise en main de l’Aperio LV1 IVD Visualisation 
live et scanner de paillasse une fois installé. Elle vous guide tout au long des premières étapes et 
jusqu’à l’imagerie live. Pour des informations détaillées concernant le mode scanner, les 
paramètres et la liste des lames, veuillez consulter les sections appropriées. 

Se connecter 
Lorsque vous démarrez l’ordinateur connecté au LV1 IVD, vous devez saisir un mot de passe 
Windows. Si c’est la première fois que quelqu’un se connecte au PC, demandez le mot de passe 
par défaut à votre représentant des services techniques de Leica Biosystems. Pour des raisons de 
sécurité, vous devriez changer le mot de passe Windows par un mot de passe choisi par vous, en 
suivant les instructions de votre documentation Windows. 

Allumer l’Aperio LV1 IVD Visualisation live et scanner de paillasse 
Allumez l’Aperio LV1 IVD Visualisation live et scanner de paillasse en appuyant sur le bouton 
d’alimentation (1), à l’avant de l’instrument. Assurez-vous que l’interrupteur d’alimentation 
qui se trouve à l’arrière de l’instrument est allumé et que l’instrument est branché à une 
source d’alimentation.  

 
 Après une courte initialisation, l’indicateur d’alimentation (1) passe de l’orange au vert.  

 Le bouton Éjecter (2) éjecte la lame. Dès que l’application Aperio LV1 IVD est démarrée, 
le bouton Éjecter qui se trouve à l’avant du LV1 IVD est désactivé afin d’éviter une 
éjection accidentelle du plateau. 

 L’indicateur d’erreur (3) est allumé lorsque l’instrument est en mode Échec. 

 Le voyant DEL « Busy » (Occupé) (4) est allumé lors de l’initialisation de l’instrument ou 
lors d’autres processus durant lesquels l’instrument est temporairement occupé. 

2 3 4 1 
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Éteindre le LV1 IVD 
Appuyez sur le bouton d’alimentation (1) situé à l’avant de l’instrument et continuez d’appuyer 
pendant 3 secondes pour éteindre le LV1 IVD. 

Charger les lames et le plateau 
Pour démarrer l’application LV1 IVD, allez dans le menu Start (Démarrer) de Windows et 
sélectionnez Aperio LV1 Console. 

 Dans l’application logicielle LV1 IVD, cliquez sur l’icône Éjecter, ainsi, l’instrument est 
prêt à accepter un plateau. 

 Placez 1 à 4 lames sur le plateau de lames, les lamelles couvre-objets orientées vers 
le haut. 

 Les étiquettes doivent se trouver sur la gauche. 

 

 
Gardez les lames propres pour obtenir la meilleure qualité d’image possible. 

 

 
 

 

Dès que l’application Aperio LV1 IVD est démarrée, le bouton Éjecter qui se 
trouve sur le panneau avant du LV1 IVD est désactivé afin d’éviter une éjection 
accidentelle du plateau. 

 

 Assurez-vous que les lames sont bien installées dans les fentes et ne sont pas inclinées. 

 Le support de plateau doit être visible à l’avant ouvert de l’instrument. 

 Introduire le plateau de lames dans le guide jusqu’en butée. Il est automatiquement 
inséré. 
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Écran de démarrage 
Au démarrage de l’application Aperio LV1 IVD, l’écran principal vous propose des liens vers les 
zones que vous utiliserez le plus souvent : Visualisation live et Liste des lames.  

 
En haut de la fenêtre, vous pouvez choisir entre plusieurs modes ou afficher la boîte de 
dialogue Réglages. 

 
 Mode de visualisation live : utilisez la visualisation live pour des examens live comme 

un microscope traditionnel, avec les avantages de l’imagerie numérique. Consultez la 
section Visualisation live.  

 Mode Scanner : scannez et numérisez automatiquement plusieurs lames. Consultez la 
section Mode Numérisation. 

 Liste des cas : consultez la liste des lames numérisées et chargez-les sur 
eSlide Manager (facultatif). Consultez la section Liste de cas. 

 Réglages : paramétrez les préférences pour l’application. Créez également un profil de 
numérisation : consultez la section Scanner. 
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4 Visualisation live 

La visualisation live comporte trois boutons.  

 
 Visualisation live lance la microscopie live, à partir de la fenêtre principale de la 

visualisation live. 

 Vous pouvez parcourir les données des images précédemment stockées en cliquant 
sur Liste des lames. 

 Le bouton Éjecter qui se trouve sur la gauche commande l’insertion ou le retrait du 
plateau de lames. 

 

 

En visualisation live, lors de l’insertion d’un plateau, ce dernier est 
automatiquement introduit dès qu’il est détecté et l’instrument affiche 
la Liste des lames live. 

 

Liste des lames live 
Lorsque vous introduisez le plateau ou que vous cliquez sur l’icône Visualisation live, 
l’Aperio LV1 IVD Visualisation live et scanner de paillasse génère une vue d’ensemble de toutes 
les lames et l’affiche sur l’écran de la liste des lames live.  
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Astuces d’utilisation de la liste des lames live 
 L’instrument réalise l’imagerie de la zone d’étiquette de chaque lame et lit le 

code-barres si un profil de code-barres est prédéfini. Dans ce cas, un identifiant de cas 
est analysé à partir du code-barres. Vous pouvez également saisir un identifiant de cas 
pour chaque lame ou l’instrument leur en attribue un par défaut. Pour obtenir une 
description détaillée de l’interprétation de l’étiquette, veuillez consultez la section 
Reconnaissance de l’étiquette. 

 Cliquez sur l’image de l’étiquette afin de la faire pivoter à 90° pour une meilleure 
lisibilité. L’orientation par défaut de l’étiquette peut être définie dans les paramètres. 

 Double-cliquez sur une lame pour l’examiner sur le champ dans la fenêtre principale de 
la visualisation live. Vous pouvez également cocher les cases en regard des lames 
souhaitées et cliquer sur OK pour les examiner simultanément dans la fenêtre principale 
de la visualisation live. 

 Cliquez sur la flèche pointant vers le bas qui se trouve sous les cases ID du cas/ID lame 
pour saisir davantage d’informations sur la lame.  
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 Consultez également la section Ajouter une lame live pour obtenir des informations sur 

le retour à la liste des lames live afin de sélectionner les lames supplémentaires à 
afficher dans la fenêtre principale de la visualisation live. 

Fenêtre principale de la visualisation live 
La zone d’images affiche la ou les lames sélectionnées. Une lame à la fois est « active » en imagerie 
live. (La lame active affiche les commandes Windows et les outils de déroulement Autofocus/Carte 
de la lame.) Cliquez sur une autre lame pour la rendre active. Lors de la navigation dans 
l’échantillon et la modification du grossissement, les informations importantes et les icônes de 
contrôle restent visibles.  

 
 Le champ ID du cas/ID lame (1). Ce champ indique si l’image est live depuis l’instrument 

(« LV » avec une barre verte) ou s’il s’agit d’une image virtuelle numérisée (« SC » avec 
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une barre bleue). Consultez la section Ajouter une vue pour obtenir des informations sur 
la duplication de plusieurs vues de la lame. 

 Les commandes de base pour réduire, agrandir ou fermier une vue de lame (2). 

 Une carte de la lame fournit une vue d’ensemble de la zone de lame ou de la 
numérisation disponible (3). Il est possible de zoomer sur la carte de la lame en cliquant 
sur le bouton Replier/Déplier la carte de la lame (4) en haut de la vue. 

 
 L’étiquette de la lame est affichée et est superposée à l’image principale (5). 

 Les options de mise au point automatique sont disponibles dans l’image principale. 
Répétez et désactivez la mise au point automatique lors de la microscopie live (6). 

Consultez la section Ajustement de la mise au point pour obtenir de plus amples 
informations. 

 Une échelle est également affichée (7). 

 Sélectionnez un grossissement directement en cliquant sur les boutons de 
grossissement (8). « OV » signifie grossissement de la vue d’ensemble, ce qui affiche 
l’image en entier. Le grossissement actif est mis en surbrillance. 

 Les fonctionnalités avancées sont disponibles à l’aide de la barre d’outils (9). Consultez 
la section Menu latéral de la visualisation live. 

À l’aide des outils qui seront abordés plus tard dans la section Menu latéral de la visualisation live, 
vous pouvez ajouter des vues supplémentaires de la même lame, ajouter des lames supplémentaires 
à partir de la liste de lames live, ajouter des vues des lames numérisées enregistrées comme des 
images numériques et inscrire des annotations et des mesures sur les vues de la lame. 
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Ci-dessous se trouve un exemple de la fenêtre principale de la visualisation live qui comprend 
plusieurs images de lame :  

1) Lame virtuelle (image numérisée), étiquetée « Slide_2 1 ». Notez la barre bleue et le code 
« SC » qui indiquent qu’il s’agit d’une image numérisée. 

2) Lame en visualisation live étiquetée « Slide_1 1 ». Notez la barre verte et le code « LV » qui 
indiquent qu’il s’agit d’une image en visualisation live. 

3) Vue supplémentaire de la lame Slide_1, étiquetée « Slide_1 2 » 

4) Vue supplémentaire de la lame Slide_1, étiquetée « Slide_1 3 »  

 

Navigation sur la lame 
Les mouvements du microscope sont contrôlés à l’aide du clavier et de la souris. 

Grossissement (zoom) 

 Clic gauche : zoome sur l’image (augmenter le grossissement) 

 Clic droit : dézoome de l’image (réduire le grossissement) 

 Boutons de grossissement : passe directement au grossissement désiré en cliquant sur 
les boutons dotés d’un code couleur qui se trouvent en bas à droite de l’écran. 
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Ajustement de la mise au point 

 Molette de la souris : ajuste la mise au point de l’image dans les images live. (La mise au 
point n’est pas disponible dans le grossissement de la vue d’ensemble.)  

 Sinon, utilisez l’outil Mise au point en haut de la fenêtre d’affichage pour sélectionner 
Autofocus, Mise au point manuelle ou Réinitialiser la mise au point : 

 

Navigation 

 Défilement manuel : cliquez et faites glisser l’image dans la direction souhaitée en 
continuant d’appuyer.  

 Utilisez les flèches du clavier pour filtrer la lame vignette par vignette (horizontalement 
ou verticalement). Les champs de vision adjacents sont affichés. Cette fonctionnalité est 
particulièrement utile lorsque vous souhaitez filtrer un échantillon systématiquement en 
une résolution plus élevée. 

 Vous pouvez cliquer en continuant d’appuyer sur le localisateur de navigation 
(rectangle/point vert) dans la carte de la lame et le déplacer, le microscope se déplacera 
de même. 

 
 En cliquant sur la carte de la lame, la vue actuelle passe à la position correspondante sur 

l’échantillon.  

 En appuyant sur la molette de la souris, le curseur se transforme en quatre flèches. Dans 
ce mode, la position de l’image suit les déplacements de la souris. Désactivez ce mode 
en appuyant à nouveau sur la molette de la souris. 
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Menu latéral de la visualisation live 
Des fonctionnalités supplémentaires sont accessibles dans une barre d’outils qui se trouve sur la 
droite, à côté de la vue principale. 

Introduire/Éjecter le plateau de lames 

 

Lame précédente/suivante 
Lorsque plusieurs lames sont disponibles sur le plateau de lames, examinez-les une par une, en 
passant à la suivante ou à la précédente à l’aide de ces deux icônes. 

 

Ajouter une lame live 
Lorsque vous ajoutez une lame live, vous visualisez toutes les lames disponibles. Sélectionnez la ou 
les lames à ajouter à la vue principale. Consultez la section Liste des lames live. Vous pouvez 
visualiser et comparer jusqu’à quatre lames de microscope dans la fenêtre de visualisation live. 

 
Cette fonctionnalité est utile lors de la comparaison de plusieurs colorations ou sections 
consécutives (par exemple, H&E et IHC).  

Les lames live ajoutées peuvent être examinées comme une lame unique. Vous pouvez passer 
d’une vue live à l’autre et ajuster la position des échantillons de façon indépendante. 

Ajouter une vue 

 
Pour examiner plusieurs positions ou zones du même échantillon, ajoutez simplement une autre 
scène de l’échantillon actif (une lame live ou numérisée). Les différentes positions de l’échantillon 
sont affichées côte à côte et peuvent être comparées. Cela est particulièrement utile lors de 
l’examen de micropuces contenant des tissus. 

Vous pouvez naviguer dans toutes les scènes ajoutées et les contrôler comme décrit précédemment. 

Il est possible d’utiliser cet outil de façon répétitive, jusqu’à 16 images maximum affichées dans la 
vue principale. 
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Ajouter une lame virtuelle 
De même que pour les lames live, des lames virtuelles déjà numérisées peuvent être ajoutées à la 
vue principale. Pour obtenir davantage de détails, veuillez vous référer à la section Liste des lames. 

 

Numérisation interactive 
Il est possible de numériser sur demande une zone souhaitée du champ de vision actuel (Mini Scan) 
de la lame active. Veuillez consulter la section Numérisation à partir de la fenêtre principale de la 
visualisation live. 

 

Outil capture 
Veuillez consulter la section Outil capture. 

 

Outil d’exportation 
Veuillez consulter la section Outil d’exportation. 

 

Ajustement de l’image 
Vous pouvez ici modifier l’apparence de l’image à l’écran. Luminosité, correction gamma, contraste 
et balance des couleurs. 

 
En outre, il existe quelques options de traitement de l’image qui s’avèrent utiles en certaines 
occasions. Trois filtres différents peuvent permettre d’améliorer les détails de l’image. Le filtre 
d’amplification est particulièrement utile pour les échantillons cytologiques, pour lesquels son 
introduction produit un effet de type « contraste de phase ». Cochez la case « sharpen » 
(accentuation des contours) pour appliquer le filtre à l’image live. 

Le cercle qui se trouve dans le coin supérieur droit réinitialise tous les réglages de l’image à leur 
valeur par défaut. 
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Outils supplémentaires du menu latéral 

 Pour obtenir des informations sur l’utilisation du plateau de lames, consultez la section 
Plateau de lames. 

 Pour obtenir des informations sur l’exportation d’images, consultez la section Options 
d’exportation d’images. 

 Pour obtenir des informations sur le dessin d’annotations et de mesures, consultez la 
section Annotation et mesure. Consultez également la section Travailler avec des 
annotations et des mesures. 

 Pour obtenir des informations sur la réalisation d’une numérisation interactive, 
consultez la section Numérisation à partir de la fenêtre principale de la visualisation live. 
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Plateau de lames 

Gestion des lames et de la vue 
Cliquez sur l’icône Plateau de lames pour ouvrir le plateau de lames. Il contient des images et des 
informations concernant toutes les lames live ou virtuelles affichées dans la fenêtre principale de la 
visualisation live. 

 

 
Le plateau de lames répertorie toutes les lames live et virtuelles qui apparaissent dans la fenêtre 
principale de la visualisation live. Le plateau de lames vous permet de gérer toutes vos lames, 
scènes (plusieurs vues ouvertes pour une lame unique), annotations et commentaires liés aux 
lames affichées.  

Par défaut, le plateau de lames est masqué. Pour faire apparaître le plateau de lames, cliquez sur 
l’icône Plateau de lames.  

Le plateau de lames est automatiquement masqué si le curseur ne survole plus l’onglet Plateau de 
lames. Il est également possible d’épingler le plateau de lames à l’aide de l’icône Épingler, qui se 
trouve dans le coin supérieur gauche de la fenêtre Plateau de lames. Le plateau de lames peut être 
épinglé par défaut en position déroulée en sélectionnant cette option dans la section 
correspondante des paramètres Affichage – Épingler le plateau de lames). 

Cliquer sur une imagette en particulier rend cette scène active sur la fenêtre principale de la 
visualisation live. Elle est agrandie dans le plateau de lames pour symboliser la scène sélectionnée. 
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Un nouveau clic gauche sur l’imagette remplace la vue d’ensemble par les méta-informations 
disponibles concernant cette lame live ou virtuelle. 

Agrandir le plateau de lames 
Deux flèches se trouvent en haut du plateau de lames.  

 Cliquez sur la flèche du bas pour agrandir la zone de la lame afin d’afficher davantage 
d’informations sur celle-ci, notamment les mesures et les annotations. (Consultez la 
section Travailler avec des annotations et des mesures.) 

 Cliquez sur la flèche du haut pour masquer la zone de la lame. 

 

 

Afficher les informations de la lame 
Pour toutes les lames affichées dans le plateau de lames, cliquez sur la flèche du bas qui se trouve 
en regard de l’identifiant de la lame afin d’examiner les informations concernant cette dernière.  

Vous avez saisi ces informations lorsque vous avez sélectionné la lame dans la liste des lames live 
avant de l’afficher dans la fenêtre principale de la visualisation live. 
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Travailler avec des annotations et des mesures 
Pour chaque lame (live ou virtuelle), si des annotations ou des mesures sont ajoutées à une image 
en particulier (consultez la section Annotation et mesure), toutes les annotations sont affichées 
dans la légende de l’image correspondante sous forme d’icônes. 

 
 Faites survoler la souris sur une icône de la légende pour voir le nom de l’annotation. Il 

s’agit du nom configuré pour l’annotation dans son menu contextuel. Veuillez faire une 
comparaison avec la section Annotation et mesure. 

 Un seul clic sur une icône affiche les annotations correspondantes au milieu de l’écran. 

 Un double clic sur une icône vous permet de sélectionner facilement un objet dans 
l’image, par exemple pour en modifier les propriétés (maj + clic droit) comme son nom 
ou sa couleur, ou le supprimer. 

Dans la zone du plateau de lames, une icône de texte dotée d’un contour rouge indique que le 
texte est actuellement masqué dans la fenêtre principale de la visualisation live. 
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Numérisation à partir de la fenêtre principale de la visualisation live 
Remarque : Le fonctionnement d’un logiciel supplémentaire peut ralentir les performances de la 
numérisation. Il est conseillé de fermer tous les programmes inutiles. 

 
Grâce à l’Aperio LV1 IVD Visualisation live et scanner de paillasse, vous pouvez définir de façon 
interactive les parties à numériser de la lame ou de l’échantillon directement dans la fenêtre 
principale de la visualisation live. (Il existe un mode Numérisation distinct pour les numérisations 
automatiques de lames.) 

Cliquez sur le bouton Scan dans le menu latéral de la fenêtre principale de la visualisation live pour 
commencer la numérisation de la lame actuelle ou d’une zone plus petite de cette dernière. Un 
assistant démarre pour vous guider en ce qui concerne la définition de la zone, la résolution 
nécessaire, le nombre de plans complexes, etc. 

Sélectionner la zone à numériser et régler les paramètres de numérisation 
Un cadre rouge commençant par la vue d’ensemble met en évidence le champ de vision actuel. Vous 
pouvez utiliser cette zone ou ajuster la taille du cadre en cliquant et en faisant glisser le cadre rouge. 

Vous pouvez définir la résolution de la numérisation (grossissement), le nombre de plans 
complexes et la distance entre les plans. 

Les étapes de progression de l’assistant sont indiquées sur le côté droit.  

 
Confirmez votre sélection en cliquant sur Suivant. 
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Numérisation 
Cliquez sur Suivant pour lancer la numérisation. 

 
Avec un grossissement de > 2,5x, le processus de numérisation commence par une carte de mise 
au point dans les zones d’échantillon détecté (détection de tissu). 

Remarque : En cas d’échantillons à faible contraste, la détection de tissu peut échouer, ce qui 
entraîne une mise au point lente, non optimale ou l’échec de la numérisation. Évitez la présence 
de poussière, de bulles et d’artefacts lors de la préparation de la lame et d’un faible contraste 
d’échantillon.  

Lors de la numérisation, il est possible de modifier le champ de commentaires de la numérisation, 
d’ajouter un titre, des remarques et ainsi de suite. Lors de l’accumulation, l’image peut être 
immédiatement examinée en effectuant un zoom avant ou en faisait défiler. La numérisation peut 
être annulée à tout moment si l’image n’est pas acceptable ou afin de redéfinir la zone. 

Options d’exportation d’images 

Outil capture 

 
Cet outil génère une capture de votre écran actuel. 
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Vous pouvez définir quels éléments sont compris dans cette capture. Activez/désactivez la carte de 
la lame, l’étiquette ou les annotations. Choisissez d’exporter la vue actuellement active ou 
l’ensemble des vues visibles (Affichage multiple). 

 
La capture est enregistrée à l’emplacement et au format de fichier de votre choix. Consultez 
également la section des réglages Capture d’écran – Format de capture d’écran par défaut ainsi que 
les sections qui suivent relatives aux captures d’écran. 

Outil d’exportation 
Exporte le champ de vision actuel en tant qu’image en haute résolution. Dans le cas d’une image 
live, la résolution dépend de l’objectif actuel.  

 
Remarque : L’utilisation de cette fonctionnalité peut entraîner l’exportation de fichiers très 
volumineux. Par exemple, les images de la zone de lame entière de 40x peuvent facilement 
dépasser 20 Go. 

Une boîte de dialogue vous guide tout au long de plusieurs étapes. 



Chapitre 4 : Visualisation live  

 

Guide d’utilisation de l’Aperio LV1 IVD Visualisation live et scanner de paillasse  
Révision B © Leica Biosystems Imaging, Inc. 2024 | Page 41 

 
Il est possible d’exporter des fichiers sous différents formats (format TIFF, BigTIFF, JPEG2000, 
Aperio .SVS). Trois niveaux de compression sont disponibles pour réduire la taille du fichier 
exporté. La fonctionnalité Exporter est particulièrement utile lorsque les données de l’image 
doivent être utilisées dans un logiciel tiers. 

Les mêmes options d’exportation sont disponibles dans la liste des lames à l’aide du bouton 
Exporter. 

Annotation et mesure 
Les icônes Annotation et Mesure sont utilisées pour ajouter des formes, du texte et des mesures 
sur l’image. Pour obtenir des informations concernant la gestion de ces objets dessinés dans le 
plateau de lames, consultez la section Travailler avec des annotations et des mesures. 

Annotation 

Lorsque vous cliquez sur l’icône Annotation , les outils d’annotation qui permettent de dessiner 
des lignes et des zones ou d’ajouter du texte sur l’image s’affichent. 
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Mesures 
Lorsque vous cliquez sur l’icône Mesure , les outils de mesure permettant de mesurer les 
distances ou les zones s’affichent. Vous pouvez mesurer des cercles, des carrés et des sélections à 
main levée. 

 
Les annotations et les mesures existantes peuvent être modifiées ou corrigées. Appuyez sur 
[maj + clic gauche] sur l’objet pour l’activer. 

Un objet activé peut être repositionné et redimensionné ou peut être supprimé en appuyant sur la 
touche Supprimer.  

Appuyez sur la touche maj + clic droit sur un objet pour ouvrir un menu contextuel. Ici, vous 
pouvez modifier les propriétés standard du dessin, de la mesure ou du champ de texte sélectionné 
et donner un nom à l’objet. 

 
Chaque objet de dessin, de mesure ou de texte est ajouté au plateau de lames. Il peut être 
sélectionné et déplacé à l’aide du plateau de lames (consultez la section Plateau de lames). 
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Liste des lames 
Les lames numérisées et celles qui ont été examinées en mode Visualisation live sont représentées 
dans la liste des lames. 

 
Les lames ou les numérisations uniques peuvent être affichées, supprimées, exportées ou 
importées à l’aide des boutons correspondants situés en bas de la liste des lames. 

Il est possible d’importer des fichiers de lames Aperio .svs. 

Il est possible d’exporter des fichiers sous différents formats et avec trois niveaux de compression. 
(Consultez également la section Outil d’exportation). 

Galerie de lames (1) 
Dans la galerie de lames, toutes les lames sont répertoriées et les informations importantes sont 
triées dans des colonnes. Chaque colonne peut être utilisée pour trier les lames disponibles, par 
exemple en fonction de l’utilisateur, de la date de création ou de la taille de fichier. 

Un outil de recherche est disponible dans le coin supérieur droit. Il est possible d’effectuer de 
simples recherches par mot-clé. Lorsque vous cliquez sur la flèche, des filtres peuvent être 
appliqués aux colonnes de la galerie. Il est possible d’associer plusieurs filtres en cliquant sur « + » 
pour rechercher les lames d’intérêt. 

Champ d’informations de la lame (2) 
Le champ d’informations de la lame indique les métadonnées de la lame sélectionnée.  
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Galerie de numérisation (3) 
Plusieurs numérisations appartenant à une lame sont répertoriées ici. Vous pouvez les trier 
en fonction de nom, de la taille et ainsi de suite. Une petite imagette représente la zone 
de numérisation. 

Champ d’informations de la numérisation (4) 
Ce champ affiche les informations concernant la numérisation active en détail. Les annotations, 
les mesures ou le texte ajouté à la numérisation sélectionnée sont répertoriés. 
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5 Liste de cas 

Cette section aborde l’utilisation de la liste de cas afin d’examiner ces derniers et, 
facultativement, de charger des cas sur Aperio eSlide Manager. 

Pour ouvrir la liste de cas, cliquez sur Liste de cas dans le menu principal qui s’affiche en haut de 
chaque fenêtre : 

 
La liste de cas apparaît : 

 
Sur cette page, vous pouvez examiner les numérisations que vous avez effectuées. Cliquez sur un 
identifiant de cas pour afficher les informations sur cette lame au bas de la page. 
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Charger des cas sur Aperio eSlide Manager 
Si l’Aperio LV1 IVD a été configuré pour se connecter à eSlide Manager, une colonne supplémentaire 
intitulée Charger est présente sur cette page : 

 
Pour charger un cas sur eSlide Manager, cochez la case Charger pour ce cas, puis cliquez sur le 
bouton Charger. Le chargement commence. Une barre de progression s’affiche dans la colonne État 
et indique l’état du chargement. 

Pour conserver le cas sur l’ordinateur LV1 après son chargement sur eSlide Manager, cochez la case 
Garder en regard de la case avant de le charger. Sinon, le cas sera supprimé de l’ordinateur LV1 
après le chargement. 
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6 Mode Numérisation 

Remarque : Le fonctionnement d’un logiciel supplémentaire peut ralentir les performances de 
l’instrument. Il est conseillé de fermer tous les programmes inutiles. Dans des cas extrêmes, le 
fonctionnement d’un logiciel supplémentaire peut entraîner un échec dû à un épuisement de la 
mémoire RAM. 

Le mode Numérisation offre la possibilité de numériser de nombreuses lames sans interruption, 
aussi rapidement que possible. 

En cliquant sur Mode Scanner dans le menu supérieur de l’application Aperio LV1, vous passez au 
menu du mode Numérisation. 

 

Scanner des lames 
Démarrez la détection et la numérisation de toutes les lames présentes dans le plateau de lames. 

Remarque : En cas d’échantillons à faible contraste, la détection de tissu peut échouer, ce qui 
entraîne une mise au point lente, non optimale ou l’échec de la numérisation. Évitez la présence 
de poussière, de bulles et d’artefacts lors de la préparation de la lame et d’un faible contraste 
d’échantillon.  

Pour obtenir des renseignements concernant la réalisation d’une numérisation interactive (qui 
n’utilise pas le profil de numérisation) dans la fenêtre principale de la visualisation live, consultez 
la section Numérisation à partir de la fenêtre principale de la visualisation live. 

Profil de scan 
Sélectionnez ici un profil de numérisation prédéfini. Ces profils déterminent la détection de tissu, 
la zone de numérisation, la résolution, etc. de la numérisation. Les profiles de numérisation sont 
générés dans la section Settings (Paramètres). (consultez la section Scan automatique). Le profil 
sélectionné ici est également appliqué lors de la numérisation automatique. 
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Éjecter 
Cliquez ici pour éjecter le plateau de lames. 

Numérisation automatique 
En mode Numérisation, les plateaux pour lames insérés sont détectés et introduits automatiquement. 
Ensuite, l’instrument démarre automatiquement la numérisation de toutes les lames disponibles à 
l’aide du profil sélectionné dans le menu principal du mode Numérisation. 
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7 ImageScope – Référence 
rapide 

Si vous transférez des lames numériques à l’Aperio eSlide Manager, vous devrez 
utiliser la visionneuse Aperio ImageScope pour visualiser ces lames numériques. 
Voici quelques brefs conseils d’utilisation de la visionneuse de lames numériques 
ImageScope. Pour en savoir plus, consultez le Guide de l’utilisateur d’Aperio 
ImageScope. 

Bien que la fonction de base de la visionneuse ImageScope soit de vous permettre de visualiser 
les lames numériques, ImageScope offre bien plus de fonctions : 

 Visualiser des lames numériques à partir de n’importe quel poste de travail sur 
le réseau. 

 Visualiser et discuter des lames numériques en temps réel depuis plusieurs endroits 
distants grâce au système de conférence pour les lames numériques. 

 Visualiser plusieurs lames numériques simultanément. 

 Appliquer des ajustements d’image en temps réel pour le contraste, la luminosité, et 
le gamma. 

 Analyser des lames numériques complètes ou des régions sélectionnées en utilisant 
des algorithmes. 

 Visualiser, annoter et analyser des images Z-Stack numérisées. 

 Pivoter des images et des étiquettes de lames numériques. 

 Utiliser la gestion des couleurs intégrée d’Aperio pour visualiser des lames numériques 
pour s’assurer que la couleur d’affichage de celles-ci est exacte. 

 Utiliser la fonction Qualité de l’image (IQ) pour optimiser l’affichage d’une lame 
numérique sur la base de sa teinte. 

 Ajouter et gérer différents types d’annotations d’images de lames numériques. 

 Faire un panoramique et agrandir instantanément n’importe quelle région de la lame. 

 Extraire une région ou des régions sélectionnées d’une lame numérique vers un fichier 
dans plusieurs choix de formats. 
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Installation 
Important ! Pour réussir l’installation d’ImageScope, vous devez d’abord vous connecter à Windows 
en tant qu’administrateur. 

1. Double-cliquez sur « My Computer » (Poste de travail) ou ouvrez l’explorateur Windows et 
naviguez vers le fichier d’installation d’ImageScope. (Il se peut que ce fichier ait été 
téléchargé à partir du site Web www.LeicaBiosystems.com/Aperio, ait été fourni sur un CD 
ou soit présent sur votre réseau; contactez votre administrateur réseau pour obtenir de 
l’aide pour le retrouver.) 

Si vous installez ImageScope sur votre DSR (Digital Slide Repository [Dépôt de lames 
numériques]), utilisez l’installateur DSRInstall; si vous installez ImageScope sur un poste de 
travail utilisateur, utilisez ClientInstall. 

2. Double-cliquez sur le fichier .exe pour lancer l’assistant d’installation. 

3. Suivez les instructions affichées à l’écran pour accepter les conditions du contrat de licence 
et installer ImageScope. 

Démarrer la visionneuse Aperio ImageScope 
Pour démarrer ImageScope, cliquez sur Démarrer dans la barre de tâches Windows, pointez sur 
Tous les programmes > ScanScope, et sélectionnez ImageScope. 

Ouvrir une lame numérique 
Il existe trois façons d’ouvrir une lame numérique dans ImageScope : 

Ouvrir une lame 
numérique locale 

(à partir de votre poste 
de travail ou d’un réseau 
local à travers le partage 
de fichiers Windows) 

Allez au menu File (Fichier) d’ImageScope et Open Image 
(sélectionnez Ouvrir l’image). Sélectionnez l’image que vous 
souhaitez enregistrer. 

REMARQUE : Si vous ouvrez une image locale au lieu d’une 
image dans eSlide Manager, les fonctions Smart sync, Tracking 
et IQ ne sont pas prises en charge pour cette image. 

Ouvrir une lame 
numérique distante 

(à partir d’un serveur 
eSlide Manager) 

1. Allez au menu File (Fichier) d’ImageScope et sélectionnez 
Access Remote Server (Accès au serveur distant). 

2. Saisissez le nom du serveur sur lequel se trouve eSlide 
Manager, définissez la valeur Port sur 82, puis cliquez sur 
Connect (Connecter). 

3. Lorsque c’est demandé, saisissez votre nom d’utilisateur et 
le mot de passe eSlide Manager. 
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4. À partir du tableau des lames numériques sur le site eSlide 
Manager, cliquez sur ImageScope sous l’image que vous 
souhaitez visualiser. 

Visualiser une lame 
numérique depuis 
eSlide Manager 

1. Connectez-vous à eSlide Manager avec votre nom 
d’utilisateur et mot de passe eSlide Manager. 

2. Utilisez les commandes de listes eSlide Manager pour voir 
les lames numériques disponibles sur votre site. 

 

Après avoir ouvert une lame numérique, elle s’affiche dans la fenêtre principale d’Aperio 
ImageScope. 

Fenêtre principale d’Aperio ImageScope 
 

 
Magnifier (Loupe) Barre d’état 

Barre 
d’outils 

Filmstrip  
(Bande  
de films) 

Zoom slider 
(Curseur  
de zoom) 

eSlide label 
(Étiquette  
de l’eSlide) 

Volet de  
fenêtre  
principale 

Thumbnail 
(Vignette) 
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 Barre d’outils : plusieurs des commandes et fonctionnalités ImageScope sont 
disponibles dans la barre d’outils. Consultez la section Barre d’outils – Référence rapide 
plus tard dans ce chapitre pour obtenir des détails. 

 Bande de film : la bande de film signale les lames qui sont ouvertes. Cliquez sur une 
image dans la bande de film pour l’afficher dans la fenêtre principale. 

Vous pouvez visualiser plusieurs lames en même temps; pour ce faire, accédez au menu 
Windows et cliquez sur Tile Horizontal (Mosaïque horizontale) ou sur Tile Vertical 
(Mosaïque verticale). Pour afficher ou masquer la bande de film, accédez au menu View 
(Afficher) et cliquez sur Filmstrip (Bande de film). 

 Curseur du zoom : vous pouvez agrandir ou réduire la vue actuelle. 

 Curseur de focalisation (non illustré) : s’affiche uniquement avec les images eSlide 
Z-Stack. Utilisé pour visualiser différentes zones focales (couches Z-Stack) sur une 
image Z-Stack. 

 Fenêtre étiquette : si une photographie de l’étiquette de la lame a été associée à la lame 
numérique, vous pourrez la voir dans la fenêtre Étiquette. Pour afficher ou masquer 
l’étiquette, accédez au menu View (Afficher) et cliquez sur Label (Étiquette). 

 Fenêtre de vignette : la vignette affiche l’image entière. Un rectangle noir indique la 
portion de l’image qui est actuellement affichée dans la fenêtre principale. Pour 
redimensionner la vignette, faites glisser son coin inférieur gauche. Pour afficher ou 
masquer la vignette, accédez au menu View (Afficher) et cliquez sur Thumbnail 
(Vignette). 

 Fenêtre loupe – Déplacez cette fenêtre vers la zone que vous souhaitez voir agrandie, ou 
déplacez tout simplement votre curseur vers cette zone. L’agrandissement par défaut de 
la loupe est de deux fois la résolution de l’image affichée dans la fenêtre principale. 
Pour redimensionner la loupe, faites glisser son coin inférieur gauche. Pour afficher ou 
masquer la loupe, accédez au menu View (Afficher) et cliquez sur Magnifier (Loupe). 

Déplacement de la zone de visualisation 
Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé et glissez le curseur de la souris 
sur la lame numérique pour avoir une vue panoramique de toute l’image. Le curseur se transforme 
en un poing fermé, . Le panorama permet de faire bouger la lame suivant la direction dans 
laquelle vous faites glisser la souris. Vous pouvez définir les options d’ImageScope pour faire un 
panoramique en marche arrière ou pour modifier la vitesse de déplacement. Pour plus 
d’informations, consultez le Guide de l’utilisateur d’ImageScope. 

Les autres méthodes de déplacement de la zone de visualisation comprennent : 

 Panorama automatique– Avec le curseur au centre de la zone de visualisation principale, 
cliquez sur la roulette de défilement de votre souris ou faites un clic droit et 
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sélectionnez Autopan (Panorama automatique) dans le menu qui s’affiche. Déplacez 
la souris dans n’importe quelle direction pour que le panoramique se fasse 
automatiquement et très rapidement dans cette direction. Pour arrêter le panorama 
automatique, cliquez n’importe où sur la lame numérique. 

 Défilement – Lorsque vous déplacez votre curseur vers le bord de la fenêtre principale 
d’ImageScope, il se transforme en une flèche : ; maintenez le bouton de la souris 
enfoncé pour faire défiler l’affichage dans cette direction. Pour arrêter le défilement, 
relâchez le bouton de la souris. 

 Vignette – Cliquez sur la vignette pour déplacer l’image principale vers cette partie de la 
lame, ou faites glisser le rectangle situé dans la fenêtre Vignette pour vous déplacer vers 
une autre zone de la lame numérique. 

 Panorama de la page – Utilisez les touches de direction du clavier pour déplacer une 
page de plein écran à la fois (par exemple, Maj. + Flèche vers la droite pour déplacer 
une page vers la droite). 

Modifier le grossissement de l’affichage 
Un double-clic sur l’image affichée dans la fenêtre principale agrandit immédiatement cette image 
jusqu’à l’agrandissement maximal. Double-cliquez à nouveau pour revenir à l’agrandissement le 
plus récemment utilisé qui n’était pas l’agrandissement maximal. 

Les autres méthodes permettant de modifier l’agrandissement de l’affichage comprennent : 

Curseur de 
zoom 

 

 Cliquez sur Fit (Ajuster) pour inscrire l’intégralité de 
l’eSlide dans la zone de visualisation principale. 

 Cliquez sur un paramètre pour effectuer un zoom en 
utilisant ce niveau de zoom. 

 Faites glisser le curseur vers le haut ou vers le bas pour 
modifier le niveau de zoom. 

 Si votre souris est équipée d’une roulette de défilement, 
cliquez sur l’image affichée dans la fenêtre principale et 
utilisez la roulette de défilement pour déplacer le curseur. 

Raccourcis clavier Utilisez la touche Ctrl+Moins pour effectuer un zoom arrière, et 
la touche Ctrl+Plus pour effectuer un zoom avant. 

Zoomer Pour agrandir une zone particulière de la lame numérique, 
cliquez sur  dans la barre d’outils d’ImageScope. Cliquez sur 
la fenêtre d’image principale et faites-la glisser en dessinant un 
rectangle pour définir la zone de zoom. 
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Annotations 
Les outils de dessin d’annotation illustrés ci-dessous sont décrits dans la section Barre d’outils – 
Référence rapide plus tard dans ce chapitre.  

 

 
 
Les annotations sont enregistrées dans des couches différentes, avec des couleurs différentes, afin 
que chaque groupe de personnes puisse avoir ses propres annotations. 

Visualiser et naviguer une image Z-Stack 
ImageScope vous permet de visualiser, d’annoter et d’analyser des couches spécifiques d’une 
image Z-Stack numérisée. ImageScope ouvre une image Z-Stack à la couche ayant la meilleure 
focalisation, tel que déterminé lorsque la lame est scannée. Lorsque vous visualisez des images 
Z-Stack : 

 Utilisez le curseur Focus (Focalisation) pour visualiser différents calques de l’image 
Z-Stack. Le numéro en bas du curseur représente le point de focalisation actuel. 

 Cliquez sur  pour visualiser les informations relatives à l’image, y compris les 
informations se rapportant à chaque couche Z-Stack. 

 Les annotations que vous dessinez sur l’image Z-Stack sont stockées dans la couche 
Z-Stack actuelle. 

 Les résultats de l’analyse effectuée sur l’image Z-Stack sont stockés dans la couche 
Z-Stack correspondante. 

Pour plus d’informations sur la visualisation et l’analyse d’images Z-Stack, consultez le Guide de 
l’utilisateur d’Aperio ImageScope et le Guide de l’utilisateur de l’analyse des images Aperio. 

Analyse des images 
Pour analyser une image*, ouvrez-la dans ImageScope. 

1. Accédez au menu View (Afficher) d’ImageScope, puis cliquez sur Analysis (Analyse). 

2. Dans la fenêtre des algorithmes, choisissez celui que vous souhaitez utiliser et définissez 
vos paramètres d’utilisation. 

3. Sélectionnez l’analyse de toute l’image ou de la zone définie par des annotations, puis 
cliquez sur Analyze (Analyser). 

Pour l’analyse par lots côté serveur dans eSlide Manager ou pour des informations sur l’analyse 
des eSlides directement dans eSlide Manager, consultez le Guide de l’utilisateur de l’analyse des 
images Aperio. 
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Mode de visualisation clinique 
Le mode de visualisation clinique offre une barre d’outils simple qui contient seulement les outils 
utilisés dans un environnement clinique. 

 Pour utiliser la barre d’outils cliniques, allez au menu View (Afficher) et sélectionnez 
View Clinical Toolbar (Barre d’outils de visualisation clinique). (Consultez la section 
Barre d’outils – Référence rapide ci-dessous pour voir les outils qui sont disponibles 
dans la barre d’outils cliniques.) 

 Pour retourner à la barre d’outils complète, allez au menu View (Afficher) et sélectionnez 
View Standard Toolbar (Afficher la barre d’outils standard). 

Barre d’outils – Référence rapide 
* Ces outils sont affichés dans le mode de visualisation clinique. 

Outil Description 

 Accès à la fenêtre Ouvrir image dans laquelle vous pourrez rechercher une lame 
numérique locale à ouvrir pour visualisation. 

 Fermeture de la lame numérique actuellement visualisée dans ImageScope. 

 Exporter les images d’une zone spécifiée sur la lame numérique. Vous pouvez 
exporter l’image de lame numérique brute, la lame numérique avec annotations 
et l’image annotée. 

 Créer une image instantanée de la fenêtre ImageScope actuelle, y compris les 
annotations. Vous pouvez enregistrer l’image comme un fichier TIFF ou JPEG. 

 Envoyer l’image instantanée par courriel. 

 Enregistrer une vue d’image comme un fichier .sis; une vue d’image comprend 
l’ensemble complet des lames numériques actuellement ouvertes dans ImageScope. 

 Accès à la fenêtre Ajustement d’image dans laquelle vous pourrez appliquer une 
couleur et autres ajustements sur la lame numérique que vous êtes en train de visualiser. 

 Accès à la fenêtre Informations image qui affiche les informations de la lame 
numérique actuellement visualisée. 

 Accès à la vue précédente de la lame numérique. 

 Accès à la vue suivante de la lame numérique (uniquement activé si vous avez d’abord 
utilisé la flèche de retour pour revenir sur une vue précédente). 
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Outil Description 

 * Synchronisation manuelle du parcours de toutes les lames numériques actuellement 
visualisées. (Cette fonction est utilisée lorsque plusieurs lames numériques sont 
ouvertes dans la fenêtre ImageScope.) 

 * Utilisation de la synchronisation intelligente de plusieurs lames numériques 
actuellement visualisées. Les régions correspondantes des images de la lame 
numérique sont synchronisées. (Même icône que pour la synchronisation manuelle, 
mais de couleur jaune.) Cette fonction n’est pas disponible lors de la visualisation de 
lames numériques locales. 

 Afficher ou masquer les axes ou les axes et la grille. 

 Afficher ou masquer le curseur du zoom. 

 Afficher ou masquer l’étiquette de la lame numérique. 

 Afficher ou masquer la fenêtre vignette. 

 Afficher ou masquer la fenêtre Loupe. 

 Affichage plein écran. (Ou désactivation du mode plein écran.) 

 Ouverture de la fenêtre Annotations dans laquelle vous pouvez créer plusieurs couches 
d’annotations, organiser et ajouter des descriptions aux annotations. 

 Pour les clients utilisant l’analyse des images, ouverture de la fenêtre Analyse. 

 Ouverture de la fenêtre Gestionnaire des liens des annotations dans laquelle vous 
pouvez lier des annotations ou des lames numériques pour créer une séquence 
de visualisation. 

 Accès au lien précédent (si un lien précédent existe). 

 Accès au lien suivant (si un lien suivant existe). 

 Déplacer la lame numérique en effectuant un panorama dans différentes directions. 

 Agrandir la zone sélectionnée de la lame numérique. 

 *Extraire une région d’une lame numérique. 

 Dessiner une annotation de forme libre. 

 Dessiner une annotation de forme libre à exclure de l’analyse. (Cela crée une 
annotation négative.) 

 * Mesurer un objet sur une lame numérique. 
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Outil Description 

 * Dessiner une région rectangulaire (ou un carré si vous maintenez la touche Maj. 
enfoncée pendant que vous dessinez). 

 Dessiner une annotation elliptique (ou un cercle si vous maintenez la touche Maj. 
enfoncée pendant que vous dessinez). 

 * Dessiner une flèche orientée vers une zone d’intérêt. 

 Marquer l’image de lame numérique avec des annotations. 

 * Sélectionner une image pour un rapport. Cette fonctionnalité n’est utile que si 
l’option eSlide Manager Reporting est installée et que le modèle de rapport que vous 
utilisez utilise des images. 

 Mesurer la distance (μm) entre deux annotations de ligne de forme libre. 

 Copier l’annotation sélectionnée. Vous pouvez coller l’annotation dans une lame 
numérique ouverte. Si vous avez exécuté une analyse sur l’annotation, seule 
l’annotation est copiée (pas les résultats de l’analyse). 

 Coller la région d’annotation copiée dans la lame numérique active. 

 Activer ou désactiver la gestion des couleurs intégrée. Uniquement utile si l’image 
contient un profil ICC incorporé. 

 * Activation/Désactivation du mode Qualité de l’image (IQ). (Cette fonction n’est pas 
disponible lors de la visualisation de lames numériques locales.) 

 * Voir les informations d’aide pour Aperio ImageScope. 

Raccourcis clavier 

Séquence 
de touches Commande 

Barre 
d’outils 
icône Action 

Touche de 
direction 

Aucun Aucun Repositionner une image 

Touche Ctrl + 
Plus 

Aucun Aucun Zoom avant 

Touche Ctrl + 
Moins 

Aucun Aucun Zoom arrière 
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Séquence 
de touches Commande 

Barre 
d’outils 
icône Action 

Ctrl Aucun Aucun Appuyez dessus pendant que vous 
dessinez une annotation pour dessiner 
l’annotation dans une taille prédéfinie. 

Ctrl + A Image > Adjustments 
(Image > Ajustements)  

Affiche la fenêtre Image Adjustments 
(Ajustements d’image) dans laquelle 
vous pouvez effectuer des réglages 
d’image sur l’image principale ou sur 
l’image Z-Stack, ainsi que charger et 
enregistrer les ajustements. 

Ctrl + B Aucun 
 

Active/désactive la gestion intégrée 
des couleurs 

Ctrl + C Edit > Copy 
(Éditer > Copier) 

 Si une annotation est sélectionnée, 
copie l’annotation sélectionnée et vous 
permet de la coller sur l’image de lame 
numérique. 

 Edit > Copy 
(Éditer > Copier) 

Aucun Si aucune annotation n’est sélectionnée, 
copie la vue actuelle de l’image de 
lame numérique et la place dans le 
presse-papiers Windows. 

Ctrl + D View > Digital Slide 
Conferencing 
(Afficher > Système 
de conférence pour les 
lames numériques) 

Aucun Ouvre la fenêtre Digital Slide 
Conferencing (Système de conférence 
pour les lames numériques) dans 
laquelle vous pouvez créer ou rejoindre 
une conférence pour une lame 
numérique. 

Ctrl + E Image > Rotate Image 
(Image > Pivoter l’image) 

Aucun Ouvre la boîte à outils de rotation 
d’image 

Ctrl + F Aucun Aucun Active/désactive la préanalyse d’image. 

Ctrl + F4 File > Close Image 
(Fichier > Fermer l’image)  

Ferme l’image actuellement ouverte 
dans ImageScope. 

Ctrl + G View > Analysis 
(Afficher > Analyse) 

Aucun Exécute une analyse d’algorithme sur 
une lame numérique locale ou distante. 
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Séquence 
de touches Commande 

Barre 
d’outils 
icône Action 

Ctrl + I Tools > Options > 
Performance 
(Outils > Options > 
Performances) 

Aucun Active/désactive l’interpolation (utilisée 
pour visualiser des images 3D). 

Ctrl + J Tools > Options > 
Performance 
(Outils > Options > 
Performances) 

Aucun Active/désactive le rendu progressif. 

Ctrl + K Image > Garder ouverte Aucun Active/désactive l’option « Keep Open » 
(Garder ouverte). 

Ctrl + L Outils > Journalisation Aucun Active/désactive la journalisation. 

Ctrl + M Aucun Aucun Affiche/masque le mappage du suivi 

Ctrl+Maj+M Aucun Aucun Affiche/masque le mappage du cache. 

Ctrl + N View > Annotations Window 
(Afficher > Annotations 
fenêtre) 

 
Ouvre la fenêtre Annotations dans 
laquelle vous pouvez travailler avec 
des couches d’annotation pour l’image 
en cours. 

Ctrl + O File > Open Image 
(Fichier > Ouvrir une image)  

Affiche la fenêtre Open Image (Ouvrir 
une image) dans laquelle vous pouvez 
rechercher un fichier image local 
à ouvrir. 

Ctrl + P Tools > Options 
(Outils > Options) 

Aucun Ouvre la fenêtre Options pour définir 
les options générales, de navigation, 
d’annotation, de performances et de 
proxy HTTP. 

Ctrl + Q Image > Quality 
(Image > Qualité)  

Active/désactive la fonction IQ. 

Ctrl + R File > Access Remote Server 
(Fichier > Accès serveur 
distant) 

Aucun Se connecte à un Aperio ePathology 
ImageServer où vous pouvez 
sélectionner une image à afficher. 
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Séquence 
de touches Commande 

Barre 
d’outils 
icône Action 

Ctrl + S Tools > Options > 
Performance 
(Outils > Options > 
Performances) 

Aucun Active/désactive le lissage des pixels. 

Ctrl + Maj Aucun Aucun Déplace toutes les annotations. 

Ctrl + T Afficher > Vignette 
 

Affiche/masque la fenêtre vignette. 

F1 Aide > Aide 
 

Ouvre l’aide ImageScope. 

F2 Aucun 
 

Active l’outil d’annotation Crayon. 

F3 Aucun 
 

Active le crayon d’annotation négative. 

F4 Aucun 
 

Active l’outil d’annotation Règle. 

F5 Aucun 
 

Active l’outil d’annotation Rectangle. 

F6 Aucun 
 

Active l’outil d’annotation Ellipse. 

F7 Aucun 
 

Active l’outil d’annotation Flèche. 

F8 View > Annotation Link 
Manager 
(Afficher > Gestionnaire des 
liens des annotations) 

 

  
Ouvre la fenêtre Annotation Link 
Manager (Gestionnaire des liens des 
annotations) dans laquelle vous pouvez 
lier des annotations de lame dans un 
ordre de visualisation spécifique. 

F9 Aucun  Active l’outil d’annotation Counter 
(Compteur). 

F11 View > Full Screen 
(Afficher > Plein écran)  

Afficher ImageScope sur l’ensemble de 
votre écran de moniteur. 

Maj Aucun Aucun Appuyez dessus pendant le dessin des 
annotations : l’ellipse devient un cercle; 
le rectangle devient un carré. 

Maj + flèche Aucun Aucun Déplace un écran à la fois. 
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Séquence 
de touches Commande 

Barre 
d’outils 
icône Action 

Maj + Ctrl Aucun Aucun Appuyez dessus pendant que vous 
dessinez une annotation ou utilisez 
l’outil d’extraction de région pour créer 
une région ayant le même format 
d’image que la taille d’annotation 
fixe prédéfinie. 

Maj + F7 View > Previous 
Annotation Link  
(Afficher > Lien 
d’annotation précédente) 

 
Si des liens d’annotation ont été définis 
à l’aide du gestionnaire des liens des 
annotations, cela permet de passer à 
l’annotation précédente dans la 
séquence de visualisation. 

Maj + F8 View > Next Annotation Link  
(Afficher > Lien 
d’annotation suivante) 

 
Si des liens d’annotation ont été définis 
à l’aide du gestionnaire des liens des 
annotations, cela permet de passer à 
l’annotation suivante dans la séquence 
de visualisation. 
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8 Réglages 

Cette section contient des informations sur toutes les sélections disponibles dans 
le mode réglages. 

Généralités 
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Langue 
Vous pouvez choisir parmi plusieurs langues prises en charge pour l’application Aperio LV1 IVD. 
Les modifications sont appliquées après le redémarrage de l’application Aperio LV1 IVD. 

Chemin d’exportation 
Ce paramètre définit le chemin par défaut utilisé dans l’outil d’exportation et la liste des lames. Il 
est également possible de modifier ce chemin dans la boîte de dialogue d’exportation elle-même. 

Format de fichier d’exportation 
Ce paramètre définit le format de fichier par défaut utilisé dans l’outil d’exportation et la liste des 
lames. Il est également possible de modifier ce format dans la boîte de dialogue d’exportation 
elle-même. 

Niveau de compression d’exportation 
Ce paramètre définit le niveau de compression des images par défaut utilisé dans l’outil 
d’exportation et la liste des lames. Il est également possible de modifier ce niveau dans la boîte de 
dialogue d’exportation elle-même. 

Chemin des captures d’écran 
Ce paramètre définit le chemin par défaut d’enregistrement des captures d’écran à partir de la 
visualisation live des lames. Consultez la section Outil capture. Il est également possible de 
modifier ce chemin dans la boîte de dialogue des captures d’écran elle-même. 

Reconnaissance de l’étiquette – Profil 
Ce menu déroulant comporte les profils d’interprétation des code-barres disponibles. Choisissez 
un profil adapté ou cliquez sur Éditeur pour ouvrir l’éditeur de reconnaissance de l’étiquette et 
créer un profil de code-barres. Reportez-vous à la section Reconnaissance de l’étiquette pour en 
savoir plus sur la création de profils de code-barres. 

Liste des lames – Afficher uniquement les lames dotées de numérisations (scans) 
Lorsque cette option est cochée, seules les lames contenant des données de numérisation 
apparaissent dans la liste des lames. Cela peut également être activé dans la liste des lames 
elle-même. 



Chapitre 8 : Réglages  

 

Guide d’utilisation de l’Aperio LV1 IVD Visualisation live et scanner de paillasse  
Révision B © Leica Biosystems Imaging, Inc. 2024 | Page 64 

Affichage 

 

Affichage – L’étiquette de la lame est-elle visible ? 
Vous pouvez définir l’affichage par défaut de l’étiquette de la lame dans la vue principale 
(consultez la section Fenêtre principale de la visualisation live).  

Affichage – Taille de l’étiquette de la lame 
L’image de l’étiquette peut s’afficher dans la fenêtre principale de la visualisation live en 
deux tailles. 
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Affichage – Chevauchement des touches de curseur 
Définissez le chevauchement des champs de vision adjacents lorsque vous utilisez le curseur/les 
flèches pour examiner l’échantillon vignette par vignette en mode Visualisation live. La valeur 0,1 
signifie que 10 % des images adjacentes se chevauchent. La valeur 0,5 indique un chevauchement 
de 50 %. Consultez la section Navigation sur la lame. 

Affichage – Sensibilité au défilement 
Le niveau de sensibilité des barres de défilement peut être ajusté ici.  

Affichage – Épingler le plateau de lames 
Lorsque cette option est activée, le plateau pour lames demeure affiché et n’est pas masqué 
lorsque la souris est déplacée. Consultez la section Plateau de lames. 

Affichage – Angle de rotation de l’étiquette par défaut 
L’image de l’étiquette de la lame peut être pivotée pour une meilleure lecture dans la fenêtre 
principale de la visualisation live. L’angle de rotation par défaut peut être défini ici. 

Ajustements de l’image 
Dans cette section, les paramètres d’affichage des images par défaut sont définis. 

 Gamma : ajuste la correction gamme de l’image dans la vue principale 

 Canal : ajuste les couleurs de l’image à l’aide des curseurs red (rouge), green (vert) et 
blue (bleu) 

 Luminosité : ajuste la luminosité 

 Contraste : augmente/réduit le contraste 

Activer le filtre d’accentuation ? : lorsque cette case est cochée, un filtre d’accentuation des 
contours est appliqué et peut être peaufiné à l’aide des éléments suivants : 

 Rayon 

 Facteur d’accentuation 

 Seuil 

Consultez également la section Ajustement de l’image. 

Entrée – Inverser la molette de la souris 
Par défaut, l’objectif du microscope se déplace vers l’échantillon lorsque vous faites rouler la 
molette de la souris vers l’avant. Ici, vous pouvez inverser ce mouvement. 

Capture d’écran – Format d’image de capture d’écran par défaut 
Cette section définit le format auquel les captures d’écran sont enregistrées. 
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Capture d’écran – Mode capture d’écran 
Lorsque vous générez une capture d’écran, vous pouvez enregistrer la vue unique de la scène 
active ou la vue multiple de toutes les scènes ouvertes. Le mode par défaut est défini ici. Consultez 
la section Outil capture. 

Capture d’écran 
Définissez la présence ou l’absence par défaut dans les captures d’écran de l’étiquette de la lame et 
d’autres éléments affichés la vue principale. Consultez la section Outil capture. 

Annotations 
Ici, vous pouvez définir les propriétés par défaut des annotations 

 Largeur de ligne 

 Style de police 

 Taille de police 

 Famille de police 
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Microscope 

 

Microscope – Mettre les lames en boucle 
En cliquant sur les flèches Suivant et Précédent, vous pouvez examiner les lames présentes 
dans l’instrument une par une. Lorsque la case Reprendre l’examen des lames depuis le 
début est cochée et que vous cliquez sur Suivant sur la dernière lame, cela vous ramène à 
la première. 

Microscope – Résolution au démarrage 
Définition de la résolution initiale utilisée dans la vue principale lors de l’ouverture d’une 
nouvelle lame. 
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Scanner 

 

Scan live – Résolution par défaut 
Lorsque vous utilisez la fonctionnalité de numérisation interactive, vous pouvez choisir la 
résolution/l’objectif utilisé pour la numérisation. Ici, l’objectif par défaut est défini dans 
la boîte de dialogue. 

Scan live – Largeur/hauteur du scan live par défaut (mm) 
Vous pouvez définir la zone de numérisation par défaut, qui peut ensuite être modifiée 
dans la boîte de dialogue de numérisation interactive. 
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Scan automatique 
Dans cette section, les profils pouvant être utilisés en mode Numérisation sont définis. Consultez la 
section Mode Numérisation. 

La première ligne sert à l’ajout d’un nouveau profil ou à la sélection d’un profil existant, pour le 
modifier ou le supprimer. 

Scan automatique – Généralités 
Modifiez le nom du profil de numérisation. 

Définissez un nom par défaut pour une numérisation réalisée avec ce profil. 

Ajoutez un commentaire standard aux numérisations réalisées avec ce profil. 

Zone de scan – Détection automatique de tissu 
Les profils du mode Numérisation peuvent définir la numérisation d’une zone fixe ou réaliser la 
détection de tissu dans une zone définie. Avec la détection de tissu, l’instrument recherche le tissu 
dans la vue d’ensemble et numérise une ou plusieurs zones comportant du tissu. La taille et la 
position des zones dans lesquelles du tissu doit être détecté peuvent être modifiées en ajustant le 
cadre de couleur dans la représentation de la lame. Pour la détection de tissu, une taille d’objet 
minimale est définie. 

Zone de scan – Zone de scan fixe 
Vous pouvez définir la taille et la position de la zone de numérisation fixe en ajustant le cadre de 
couleur dans la représentation de la lame de microscopie. La zone entière est numérisée sans 
détection de tissu. 

Résolution de scan et Z-stacks 
Vous pouvez choisir parmi les résolutions (objectifs) disponibles à utiliser pour la numérisation. 

Vous pouvez acquérir jusqu’à 5 plans complexes afin de garantir une imagerie complète des 
échantillons plus épais. 

En utilisant les boutons +/-, vous pouvez sélectionner la distance entre les plans complexes. Les 
distances complexes proposées dépendent des objectifs sélectionnés. 

Post-scan 
Lorsque cette option est cochée, le plateau de lames est automatiquement éjecté une fois la 
numérisation terminée. 

Reconnaissance de l’étiquette 
Les étiquettes des lames sont imagées et visibles dans la fenêtre principale de la visualisation live. 
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Les code-barres de la zone de l’étiquette peuvent être interprétés. L’utilisation de code-barres 
automatise le flux de travail et réduit le risque d’erreurs. Notez que des codes-barres de mauvaise 
qualité peuvent être mal interprétés. Veuillez consulter la section Lecture de codes-barres. 

Les profils de code-barres peuvent être définis afin d’établir les champs d’informations et le 
contenu du code-barres. 

Éditeur de reconnaissance des étiquettes de code-barres 
Plusieurs formats de code-barres différents sont disponibles. L’Aperio LV1 IVD Visualisation live et 
scanner de paillasse les interprète et utilise des parties des informations contenues dans le 
code-barres. Des profils sont utilisés pour définir l’interprétation des codes-barres. Les profils sont 
générés et sélectionnés dans la section des paramètres (Reconnaissance de l’étiquette – Profil) en 
tant que profil actif de l’instrument.  
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Pour que l’instrument connaisse un nouveau code-barres, vous devez créer un profil à l’aide des 
paramètres de l’éditeur de reconnaissance de l’étiquette, qui peuvent être lancés à partir de la 
section Reconnaissance de l’étiquette de l’onglet Généralités des réglages. 

1. Insérez une lame dotée du nouveau code-barres dans l’instrument et faites lire ce dernier 
par l’application Aperio LV1 IVD. 

2. Dans l’onglet Généralités de la fenêtre Réglages, allez au champ Reconnaissance de 
l’étiquette, puis cliquez sur Éditeur pour lancer l’éditeur de reconnaissance de l’étiquette 
(illustré ci-dessus). 

3. Cliquez sur Nouveau profil et saisissez un nom de description. 

4. Cliquez sur Sélectionner une étiquette pour examiner les 10 dernières étiquettes lues par 
l’Aperio LV1. Choisissez une étiquette qui contient un code-barres en cliquant dessus. 

5. Cliquez sur la liste déroulante Type de code-barres et sélectionnez le type de code-barres 
qui correspond à celui de l’étiquette. 

6. Cliquez sur Démarrer la reconnaissance. Le texte reconnu est présenté dans la zone 
Résultats. 

Si vous rencontrez un problème (par exemple « Texte introuvable »), vous pouvez ajuster 
l’orientation de l’étiquette ou réduire la zone de l’étiquette à interpréter en définissant un 
sous-cadre dans l’image de l’étiquette à l’aide de la souris. 

Lorsque le code-barres a été correctement interprété, il est possible d’extraire des parties de 
ses informations. Dans la section Mappage du contexte 

 Les codes-barres binaires peuvent être convertis en nombre décimal. 

 Le texte d’intérêt (TOI) peut être extrait de la chaîne du code-barres. 

 Du texte fixe peut être ajouté aux informations lues dans le code-barres. 

 Plusieurs parties du code-barres et du texte fixe peuvent être associées à l’aide de la 
fonction « Associer les champs ». 
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A Dépannage 

Cette annexe contient des conseils pour trouver la solution aux problèmes les plus 
courants de votre instrument. 

Étapes de dépannage 
Si les informations ci-dessous ne vous permettent pas de régler votre problème, contactez votre 
représentant des services technique pour obtenir une assistance technique supplémentaire. 
Consultez la couverture de ce guide afin d’obtenir les coordonnées pour votre pays. 

Symptôme Solution 

Les lames sont coincées à 
l’intérieur de l’instrument 
en raison d’une panne de 
matériel ou d’alimentation 

Éteignez l’instrument et débranchez le cordon d’alimentation 
avant d’utiliser la porte d’accès latérale pour accéder aux lames. 
Consultez la fin de cette annexe pour obtenir des informations 
sur le retrait de lames brisées. 

Les informations ne se 
propagent pas correctement 
dans les champs 
d’informations sur la lame  

 Vérifiez que le code-barres/l’étiquette correspond au 
profil défini. 

 Vérifiez une éventuelle mauvaise qualité d’impression du 
code-barres, un mauvais positionnement ou la présence 
de saleté. 

 Vérifiez que la reconnaissance du code-barres a été 
correctement configurée.  

 Vérifiez que le type de code-barres est pris en charge. 

Impossible d’effectuer la 
mise au point sur la lame  

 Vérifiez que le dessus de la lame est bien orienté 
(étiquette et lamelle couvre-objet orientées vers le haut). 

 Vérifiez la présence de poussière, d’éraflures, de bulles 
et de résidus sur les lames. Nettoyez les lames.  

 Assurez-vous que les lames sont correctement préparées. 

Aucun instrument détecté 
(aucune connexion entre 
l’ordinateur et l’instrument)  

 Vérifiez le bon branchement de l’ordinateur et de 
l’instrument. Corrigez et redémarrez l’application.  

 Après ouverture de la porte latérale : Vérifiez que la 
porte latérale est bien fermée. Redémarrez l’instrument 
et l’application. 
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Symptôme Solution 

Les numérisations ou les 
lames ont été ignorées lors 
de l’analyse automatique 
des numérisations  

 Il est possible que la pré-mise au point des lames 
échoue : consultez l’entrée « Impossible d’effectuer la 
mise au point sur la lame ». 

 Vérifiez la bonne orientation des lames. L’instrument 
ne peut pas effectuer la mise au point sur des lames 
retournées. 

 Vérifiez la présence de poussière ou d’autres résidus sur 
les lames. Nettoyez les lames. 

Les lames du plateau 
de lames ne sont pas 
détectées 

 Vérifiez la bonne orientation des lames. 
 Vérifiez la présence d’une étiquette sur le côté gauche de 

la lame; les étiquettes se trouvant du côté droit ne sont 
pas lues. 

Le bouton Eject (Éjecter) 
de l’instrument ne 
fonctionne pas  

C’est normal lorsque l’application est en cours de 
fonctionnement : le bouton Eject (Éjecter) de l’instrument est 
inactif afin d’éviter le retrait accidentel des échantillons. 

Le disque dur de stockage 
des lames est plein.  

Libérez de l’espace sur le disque dur local en chargeant les 
données de la lame ou par le biais de la maintenance de service 
(suppression des données). 

 

Ouverture de la porte d’accès 
En cas d’urgence, vous pouvez avoir besoin d’accéder à l’intérieur de l’instrument en ouvrant la 
porte d’accès. Veuillez d’abord appeler les services techniques Leica pour obtenir de l’aide ainsi 
que des instructions.  

Si l’on vous dit d’ouvrir la porte d’accès, éteignez d’abord l’instrument et débranchez le cordon 
d’alimentation. Pour ouvrir la porte d’accès, utilisez la clé hexagonale fixée à l’arrière de 
l’instrument pour déverrouiller la porte, puis tirez pour retirer cette dernière. 
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N’utilisez pas l’instrument lorsque la porte latérale est ouverte. Utilisez la clé hexagonale pour 
refermer la porte lorsque vous avez terminé. 

Éjection manuelle du plateau de lames 
Par la porte d’accès, vous pouvez voir une poignée verte que vous utiliserez pour pousser 
manuellement le plateau d’échantillons en position d’éjection.  

 
Pour éviter d’endommager les mécanismes de la platine XY ou le boîtier, positionnez d’abord la 
platine au milieu (cette position est atteinte lorsque les deux autocollants fixés à la plaque base et 
à la plaque supérieure de la platine sont alignés sur un axe vertical. Depuis cette position, la platine 
peut être poussée directement vers l’avant de l’instrument, jusqu’à ce qu’elle atteigne la position 
d’éjection. 
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Nettoyage de l’intérieur du scanner 
Avant de nettoyer l’intérieur du LV1, téléphonez aux services techniques Leica (voir Support client) 
pour obtenir de l’aide et des instructions. Si un nettoyage important s’avère nécessaire, n’essayez 
pas de le faire vous-même et téléphonez aux services techniques Leica pour programmer 
un entretien. 

 

 

En particulier lorsque des échantillons infectieux ont été utilisés dans l’instrument, 
procédez avec la plus grande précaution lors du retrait de bouts de verres et de 
substance biologique en vous conformant aux procédures et aux politiques de 
sécurité biologique de votre établissement en ce qui concerne la manipulation de 
substances biologique en toute sécurité. Mettez le scanner hors tension et 
débranchez le cordon d’alimentation avant d’ouvrir la porte latérale et de mettre 
les mains à l’intérieur de l’appareil.  

 

Retrait de lames brisées 
En utilisant les dispositifs de protection appropriés et en suivant les procédures de sécurité 
pertinentes, ramassez et essuyez tous les morceaux de lames brisées visibles. Évitez de faire 
entrer du liquide dans l’instrument. Prenez garde d’érafler les surfaces optiques qui se trouvent 
à l’intérieur de l’instrument avec des pinces ou d’autres outils. Utilisez un chiffon sec et non 
pelucheux pour ramasser les petits débris de verre dans la platine XY et la plaque basse de 
l’instrument. Retirez tous les gros morceaux de verre de la platine XY. 



 

Guide d’utilisation de l’Aperio LV1 IVD Visualisation live et scanner de paillasse  
Révision B © Leica Biosystems Imaging, Inc. 2024 | Page 76 

 

B Raccourcis clavier 

Cette annexe comporte les raccourcis claviers que vous pouvez utiliser dans 
l’application Aperio LV1 IVD. 

Clé Action 

Escape (Échap)   Désactive toutes les annotations présentes dans la 
lame/numérisation actuelle  

 Quitte le plein écran  
 Quitte le mode d’édition dans la commande du nom de 

la lame  

Supprimer Supprime les annotations actives présentes dans la 
lame/numérisation actuelle  

Page haut/bas Modifie la mise au point dans la scène actuelle  

Home/End (Début/Fin) Zoom avant/arrière sur la scène actuelle  

Gauche/Droite/Haut/Bas Permet de se déplacer dans la scène actuelle  

Maj + Gauche + Clic Active une annotation ou une mesure  

Maj + Droite Clic Menu des propriétés des annotations/mesures  

Ctrl + Gauche + Clic Bascule en plein écran pour la scène actuelle  

Alt + F4 Quitte l’application  
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Symboles 

Les symboles suivants peuvent apparaître sur l’étiquette de votre produit ou dans ce 
guide d’utilisation : 

 
ISO 15223-1 – 5.4.3 Lire les instructions d’utilisation 

 ISO 15223-1 – 5.1.1  Fabricant 

 ISO 15223-1 – 5.1.3  Date de fabrication 

 ISO 15223-1 – 5.5.1 Dispositif de diagnostic in vitro 

 ISO 15223-1 – 5.1.7  Numéro de série 

 
ISO 15223-1 – 5.3.8 Limite de taux d’humidité 

 ISO 15223-1 – 5.1.6  Référence 

 
ISO 15523-1 – 5.7.3  Limitation en température 

 
ISO 15223-1 – 5.4.1 Risques biologiques 

 
2012/19/EU 

L’appareil est régulé en vertu de la directive 2012/19/UE (Directive WEEE) 
relative aux déchets d’équipements électriques et électroniques et doit 
être mis au rebut dans des conditions spéciales. 

 
ISO 15223-1 – 5.4.4 Attention 

 
ISO 7010 – W001 Avertissement général 

 
ISO 7010 – W012 Mise en garde : Caractéristiques électriques 

 
ISO 7010 – W017 Mise en garde : Surface brûlante 

 
ISO 60417 – 6040 Rayonnement ultraviolet, protection pédagogique 
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